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Upgrading to Octel® 100 Version 3.2 from Octel® 100 Version 3.1

This note provides the steps for upgrading Octel® 100 3.1 systems to Octel® 100 Version

3.2.

Steps for installing OS/2 Fix Pak 40 are also provided. You must install Fix Pak 40 before
you upgrade to Octel 100 Version 3.2, unless you migrated to a new PC.

Required Materials

The following materials may be required for the upgrade. Make sure that you have the
required materials available before beginning the upgrade:

A medium you can use to back up files on the system, such as diskettes or a tape
backup device

Any hardware required to upgrade the system, including voice or fax boards, RAM,
or a Sentinel device, as well as accessory tools you may need, such as a
screwdriver

A sentinel upgrade utility (SUU), if adding optional modules

An anti-static wrist strap, if you will be handling voice or fax boards
Octel 100 v3.2 Upgrade CD-ROM

The PC manufacturer's documentation, if you are upgrading RAM

Octel 100 Version 3.2 Implementation and Service Manual

Procedures in this note assume that the hard drive on which the system is installed is
drive C, that any additional hard drive that may be installed is D, that the disk drive is A,
and that the CD-ROM drive is E. Drive designations on the specific PC on which you are
working may vary. Confirm the appropriate drive letters, when necessary, in procedures
provided in this note.
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UPGRADING FROM OCTEL 100 VERSION 3.1 TO VERSION 3.2

Installing OS/2 Fix Pak 40

0OS/2 Warp Fix Pak 40 must be installed on PCs running OS/2 Warp 3.0. IBM issued Fix
Pak 40 to address OS/2 Warp 3.0 operating system anomalies.

WARNING: If you migrated to a new PC, you must NOT install OS/2 Fix Pak 40. Fix

Pak 40 should only be installed on systems running OS/2 Warp 3.0.

To install OS/2 Warp Fix Pak 40:

1.

o~ wDw

Shut down the messaging system if it is running:

a.
b.

Log into the messaging system as a Level 2 or 3 supervisor.

To shut down the system, select Exit from the File menu. A dialog box displays a
message prompting you to indicate how to shut down the system.

Click OK to perform the shutdown. A dialog box displays a message asking if
you want to wait for channel activity to cease. Wait for channel activity to cease.
Do not click Force. When all the ports are inactive, the system shuts down.

Insert the CD-ROM labeled “Octel 100 v3.2 Upgrade” in the CD-ROM drive.
Open an OS/2 window if one is not already open.

From the C: prompt, type E: and press <ENTER>.

From the E: prompt, type i nstfp40 and press <ENTER>. The OS/2 Warp Fix Pak
40 install begins. This step may take several minutes.

When the file update is complete, the OS/2 window displays a message that the Fix
Pak 40 file transfer is complete. Press any key to continue.

To close the OS/2 window, type EXI T and press <ENTER>.
Restart the PC:

a.

b.

C.

Click the right mouse button on an empty area of the OS/2 desktop and select
Shut down from the menu that displays.

When you are prompted whether you want to close all windows and active
programs, click OK.

When prompted to shut down or reboot, press <CTRL+ALT+DEL> to restart the
PC. Once the PC restarts and the OS/2 desktop displays, complete the
procedure to perform the upgrade to Octel 100 Version 3.2.
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UPGRADING FROM OCTEL 100 VERSION 3.1 TO VERSION 3.2

Preparing for the Upgrade to Octel Version 3.2

Complete the following procedures to prepare for the upgrade to Octel 100 Version 3.2:

1. Shut down the messaging system if it is running:

a.
b.

Log into the messaging system as a Level 2 or 3 supervisor.

To shut down the system, select Exit from the File menu. A dialog box displays a
message prompting you to indicate how to shut down the system.

Click OK to perform the shutdown. A dialog box displays a message asking if
you want to wait for channel activity to cease. Wait for channel activity to cease.
Do not click Force. When all the ports are inactive, the system shuts down.

2. Run Quick Assist Update Partial:

a.
b.

Double-click the Octel icon to open the Octel folder.

Double-click the Quick Assist icon in the Octel folder. The Quick Assist dialog
box displays.

Click Recover Files. The Recover Files dialog box displays.

In the Drive where \cvrl files are located field, verify that the displayed drive is
the drive where the \CVR1 directory is located.

In the Mailbox to receive unattached messages field, enter the mailbox in which
you want the system to place messages with invalid header information.
(Unattached messages with valid header information are placed in the new
message queue of the receiving mailbox.) Messages are only put in this mailbox
if the Delete unattached messages option is disabled.

Under Recovery Mode, select the Update (partial) option.

Under Recovery Options, select the Ask before creating a mailbox option if you
want the system to prompt you for confirmation before it creates mailboxes. The
system creates mailboxes when it finds messages or greetings that are linked to
a mailbox number that does not exist. If you deselect this option, the system
automatically creates the mailboxes indicated by the message or greeting links.

Under Recovery Options, select the Delete unattached messages option if you
want the system to automatically delete unattached messages. If you disable this
option, unattached messages with valid header information are placed in the
mailbox in the message header, and unattached messages with invalid header
information are placed in the mailbox you specified in step 2e.

In the Report Filename field, enter the name of the report you want the system
to generate. The default is QASSIST.RPT.

Under Report Options, select the Send to File option if you want to create a
report file. When you select this option, the system creates a report with the
specified filename in the \CVRL1 directory. If you deselect this option, the report
is only available by selecting the View Report option.

To begin the update, click Start. The Recover Status dialog box displays. The
system copies the files in the \CVR1 directory into a directory named
\~REPAIR~. Do not delete the files from the \~REPAIR~ directory until you are
confident the system has corrected any file damage.

The Searching Directory and Processing Mailbox fields display the directory and
mailbox currently being processed. The Errors and Warnings fields reflect the
respective number of errors and warnings the system encounters during the
update.
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UPGRADING FROM OCTEL 100 VERSION 3.1 TO VERSION 3.2

m. When the partial update is complete, you can click Edit Mailboxes to reenter or
modify information that may have been lost. The Mailbox Quick Edit dialog box
displays with information for the first mailbox.

This dialog box includes general identification information about each system
mailbox, including the First and Last Name, Company, and Division. The
Messages box displays the number of recovered New and Saved messages.

You can click the Next and Previous buttons to move through the mailboxes.
Click Save to save any edits you make. When you finish making any edits, click
OK to return to the Recover Status dialog box.

n. Click OK. The Recover Files dialog box displays.

0. To display the report, click View Report. If the system detected errors or
warnings during the update, the appropriate corrective action is suggested in the
report. If Quick Assist recommends further action, such as performing an Update
All or Rebuild All, contact a technical support representative before continuing.

p. When you finish viewing the report, click the window icon in the upper-left corner
and select Close. The Recover Files dialog box displays.

g. Click Cancel. The Quick Assist dialog box displays.
r. To close Quick Assist, click Exit.
s. Double-click the icon in the upper-left corner of the folder window to close it.

Shut down any open applications (for example, UPS, SMDI) and windows except the
0S/2 desktop and the OS/2 window:

a. Press <CTRL+ESC> to open the Window menu.

b. Highlight any application you see with the exception of the OS/2 desktop or the
0OS/2 window.

Click the right mouse button once on the open application.
d. Select Close.
e. Repeat steps 2a — d for each open application.

Performing the Upgrade to Octel Version 3.2

Complete the following steps to successfully upgrade to Octel 100Version 3.2:

1.

Insert the CD-ROM labeled “Octel 100 v3.2 Upgrade” in the CD-ROM drive into the
CD-ROM drive. If you have just installed OS/2 Warp Fix Pak 40, the CD-ROM
should still be in the CD-ROM drive.

Open an OS/2 window.

In the OS/2 window, from the C:\ prompt, type E: and press <ENTER> to change
to the CD-ROM drive.

Do not attempt installation from the full screen OS/2 window because the installation
process will run in the background, and the installation screens will not be visible to
you. Consequently, you cannot follow the prompts.

From the E:\ prompt, type CD VM then press <ENTER>. The \VM directory prompt
displays.

From the \VM directory prompt, type | NSTALL and press <ENTER>. The message
“Setup is initializing, please wait...” displays.
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UPGRADING FROM OCTEL 100 VERSION 3.1 TO VERSION 3.2

6. A window displays which briefly describes the installation procedure. To continue

installing, click Continue or press <C>. The installation program presents a list of
drives from which you can select.
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7. Select the drive on which the current Octel 100 system is installed. Use the down

arrow key to highlight the appropriate drive, then click OK. (Drives A and B are disk
drives.) The system prompts whether you want to install the system to the \CVR
directory on the specified installation drive.

[%ew | | me |

Click Yes to install the system to the \CVR directory and continue the installation
process. If you click No, you are prompted to enter a destination directory.

To facilitate system maintenance, it is recommended that you do not change the
default installation directories.

You are prompted whether you want to back up the voice mail system. If you select
Yes, the system backs up the CVR, CVR1, and REPAIR directories to the
\OSP_OLD directory, which contains CVROLD, CVR10LD, and REPROLD
directories, respectively. It is strongly recommended that you select Yes back up the
voice mail system.
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UPGRADING FROM OCTEL 100 VERSION 3.1 TO VERSION 3.2

10. Wait while the system prepares to load files. A dialog box with installation options

11.

12.

13.

14.

15.

and space requirements displays. The Space Requirements section of the window
displays the disk space required, based on the selected options, the space
availability, and the installation and boot drives.
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Under Installation Options, leave all of the options selected:

¢« Program Files — Includes the executable files needed to run the messaging
system.

e Utilities — Contains the files necessary to run system modules, such as DialPlan
and Integrator.

Under Voice Files, make sure that all of the options are deselected as there have
been no changes to the phrase files for this version.

WARNING: If you select Voice Files, any custom phrases in the selected
language will be overwritten.

Under Voice Drivers, select the type of voice board installed in the system PC from
the drop-down menu.

Under Serial Integrations, verify that the option displayed is correct. If it is not, select
the appropriate option from the drop-down menu.

You can exit the installation at this point by clicking Exit. After you select Install, you
cannot exit the installation process.

Click Install to install Octel 100 based on the selections.

A small display appears to the left of the Disk Prompt window to show the
progression of the installation process. The graph represents the percent of hard
drive space and memory being used, as well as the progression of each file as it is
copied from the disk to the hard drive. If the Low icon comes on during installation,
do not be concerned.
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UPGRADING FROM OCTEL 100 VERSION 3.1 TO VERSION 3.2

16.

17.

18.

19.

20.

21.

22.
23.
24,

When the system then prompts you to indicate whether you want the messaging
system to launch automatically upon bootup, click Yes. This configures Octel 100 to
launch each time you restart the PC and allows you to run third-party maintenance
utilities from the RUNVM.CMD file. For information on modifying the RUNVM.CMD
file, see the topic, "Verifying Files After Installation," in Chapter 6, “Installing the
Software,” in the Implementation and Service Manual.
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If you selected Yes in step 16, you are prompted to indicate whether you want the
UPS monitor to load automatically upon boot up. Select Yes if the UPS is currently
integrated with the messaging system or you are planning to run UPS integration so
the UPS monitors messaging system status to recognize a potential interruption in
operation before it occurs. For additional information on the UPS monitor, see
Chapter 11, “Integrating with an Uninterruptible Power Supply,” in the
Implementation and Service Manual.

Select No if you do not want the UPS monitor to load upon boot up.

Programs that load prior to the desktop coming up under OS/2, such as UPS, display
a default OS/2 icon on the desktop rather than the custom icon.

If you installed a serial integration, you are prompted whether you want the serial
integration to launch automatically on bootup. Click Yes.

A dialog box displays informing you that the file installation is complete. Click OK to
continue with system configuration.

The Installation Setup Utility dialog box displays a list of utilities you can run to help
you configure the Octel 100 system.
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Click Done to exit the Installation Setup Utility dialog box. The system then
completes the installation. When installation is complete, the system displays a
message reminding you to restart the computer for any changes to take effect. Do
not reboot at this time.

To close the dialog box and return to the OS/2 window, click OK.
To exit the OS/2 window, type EXI T then press <ENTER>.

Verify that the OS/2 desktop archive and recovery choices options are enabled:
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UPGRADING FROM OCTEL 100 VERSION 3.1 TO VERSION 3.2

Click the right mouse button on an empty area of the OS/2 desktop and select
Settings from the menu that displays. The Desktop — Settings window displays.

Click the Archive tab.

In the Archive System Files box, make sure that the option to Create system
archive at each restart is enabled.

In the Display Recovery Choices Screen box, make sure that the option to
Display Recovery Choices at each restart is enabled.

In the Timeout for Recover Choices screen field, enter 5 if it is not already set
to 5.

Double-click the icon in the upper-left corner of the window to save the settings
and close the window.

25. If the system is not connected to a Norstar switch, skip to step 26. If the system is
connected to a Norstar switch, make sure that for every 32 active extensions, at
least 1 port is enabled for Message Indicator Outbound on the Port Parameters
screen in System Setup. For example, if the system has 96 active extensions, make
sure that at least 3 ports are enabled for Message Indicator Outbound on the Port
Parameters screen. For information on modifying the Port Parameters screen in
System Setup, see Chapter 13, “Setting Up the System,” in the Implementation and
Service Manual.

26. Remove the CD-ROM.

27. Restart the PC:

a. Click the right mouse button on an empty area of the OS/2 desktop and select

b.

C.

Shut down from the menu that displays.

When you are prompted whether you want to close all windows and active
programs, click OK.

When prompted to shut down or reboot, press <CTRL+ALT+DEL> to restart the
PC.

If the voice system does not start up as it should, contact a technical support
representative immediately.
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Issues Addressed in Octel 100 Version 3.2

The following program changes have been made in Octel 100 Version 3.2:

Three parameters new are now supported by the ICONFIG utility: MWLWAIT,
NAKQUEUE, and MWLQSIZE so that they will be saved in the SI.CFG file and no
longer be overwritten when ICONFIG is run.

A problem was addressed where an access violation occurred while attempting to
print a report while a different report is still in progress.

Corrected an issue where DID Calls to a busy station failed integration.

Corrected an issue where changes to Greeting by Port setup changes were always
properly saved when the “Copy to Port...” option was used.

Corrected an issue where messaging system database files were not always
accessible after the messaging system was shut down on systems with Visual
Mailbox.

Corrected the Go to Automated Attendant, Get Mailbox and Go to Voice Mail, Get
Mailbox inband templates for the Lucent Legend and Partner switches so the correct
action is executed.

The OS/2 option to create an archive at each system restart is now enabled. This
allows the most recent desktop settings to be recovered if necessary.

Corrected an issue where an incorrect prompt was voicing for the Go to VM, Get
Mbox function.

Corrected an issue where ICONFIG settings were not being retained after an
upgrade.

Improved inband templates for serial integrations.
The UPS Integrator can now be minimized to an icon and resized properly.

An issue with OS/2 that could cause incomplete shutdowns has been addressed by
upgrading to OS/2 FixPak 40 on existing systems.

Corrected incorrect Ml codes in SWDATA.TXT for Mitel SX2000 COV integration.

An issue was corrected where a blank dialog box displayed during a CEO to Octel
100 upgrade.

Corrected an issue where, when upgrading from OPC 1.02, the dialog box instructing
the installer to review the inband templates and make sure they are configured
properly did not display.

Corrected an issue where the Dialogic D/42D-NS was not receiving the proper
Caller-1D on the new Norstar Compact ICS KSU.

Modified Configuration Note for the NEC 2000 to include requirement of adding —
PXXXX to NEC.EXE file.

Modified the SWDATA.TXT file to correct incorrect default codes for some functions
on Lucent switches.

Updated OctelNet to send more descriptive return codes for administrative
responses.

Corrected an issue where message confirmations to 10-digit mailboxes on an
OctelNet node were not working properly.

Corrected an issue in SMDI.TPT that generated an error message.
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UPGRADING FROM OCTEL 100 VERSION 3.1 TO VERSION 3.2

Added MW!I refresh. See, “Refreshing Message Indicators,” in Chapter 23,
“Maintaining the System,” in the Implementation and Service Manual.”

Corrected an issue where the runvfs.cmd could not be shut down.

Added Serial Number parameter to Networking parameters in System Setup. See
the Serial Number parameter description in Chapter 13, “Setting Up the System,” in
the Implementation and Service Manual.”

Corrected an issue where the System Setup utility could not be accessed from the
desktop when the OS/2 System Setup Icon View was open.

Tone tables have been added for the Lucent Prologix switch.

Changed the SI.CPP file to use a 4-digit year instead of 1 2-digit year. The result is
the Serial integration log now correctly processes dates after 1999.

Addressed an issue where NameNet entries were sometimes being deleted in
isolated situations.

Corrected an issue that caused an incorrect time to be voiced when a subscriber
received a message that was sent with Future Delivery to a distribution list.

Added new D42NS.FWL file.

Corrected an issue where the Mailbox Information Report was not correctly updating
the Date of Last Use parameter.

Corrected an issue where users cannot send messages to an OctelNet node if the
number of retries has been exhausted by administrative calls to the note.

Removed support for the MD110 integration.

There is a limitation on the Norstar switch that only permits 32 message indicator
requests to be turned on a particular channel. This release of the Octel 100
overcomes this limitation.
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